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7 Introduction 

Introduction 

This document is a user’s manual for the FandPLimitTool V1.2 and MUMDesignTool V1.0. It 

provides detailed instructions for performing five specific calculations which are representative of 

the types of calculations that can be performed with this application. Moreover, it provides detailed 

information about how to use the MUMDesignTool to design the focal plane spacing for a multifocal 

plane microscopy (MUM) setup [1]. 

Consider the following terminology which will be used multiple times throughout this 

document. 

FLAM: fundamental localization accuracy measure 

PLAM: practical localization accuracy measure 

FREM: fundamental resolution measure 

PREM: practical resolution measure 

What is new?  

We have added several new features to the FandPLimitTool V1.2 which make it more powerful 

and faster than its previous version (V1.1). The new features are listed as follows and each option 

will be discussed in detail later.   

 A new software module ‘the MUMDesignTool’ is incorporated with the package which 

provides tools to design the focal plane spacing for multifocal plane microscopy. 

 New functionality that allows the calculation of the 3D resolution measure. 

 A new function called "vary a parameter" is added to the software which allows users to 

calculate and plot the limits of accuracy for a range of different experimental parameters. 

 New functionality that allows simulating single molecule model and data images.  

 New functionality that allows determining limits of accuracy in the presence of stochastic 

signal amplification, i.e. when using an electron multiplying CCD (EMCCD) detector. 

 The code is significantly optimized. The software therefore runs much faster than the 

previous version. 

 Exporting tools are enhanced and user can now export the results, parameters, simulated 

model and data images and graphs as text, image and LaTex report files, respectively. 

 Summary of all input parameters can be explored within the software. 

 Enhanced user interface design. 

 A console window and a log file to facilitate bug reporting.  

Software overview 

The FandPLimitTool allows users to determine the fundamental and practical limits of 2D and 

3D localization accuracy and resolution for a variety of imaging conditions. The software has been 
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built using object oriented programming methodologies and has been designed for flexibility to 

accommodate new models and numerical calculation routines in the future. 

Each calculation supported by this application requires a different set of parameters. The 

parameters are divided into two categories: Required parameters, and Advanced parameters.  

Required parameters are those parameters that specify the imaging conditions under which the 

calculations are to be performed. Users must provide values for these parameters before a 

calculation can proceed. These parameters by default are visible to the user when software starts. 

They can also be accessed by clicking the Required Parameters option under the Parameters Menu or 

through its shortcut Ctrl+U. Although default values are always provided for all required 

parameters, users must modify the fields to suit their desired imaging conditions.  
 

 

Advanced parameters, on the other hand, are optional inputs that govern the numerical routines 

involved in performing the required calculations. These parameters are optional; the default values 

supplied for these inputs will work for typical imaging conditions. Advanced parameters can be 

accessed by clicking the Advanced-Parameters option under the Parameters Menu or through its 

shortcut Ctrl+N. For details about specifying values for advanced parameters, please refer to 

Section 1 to Section 5.  

Clicking the Parameter Summary option under the View Menu or hitting Ctrl+P provides a 

summary of the required and advanced parameters in a plane text format. This helps to 

conveniently review and save the parameters as a text file. In addition, clicking the Console option 

under the View Menu shows a console window in which the details of calculations will be listed. 

This console window is also helpful for bug reporting purposes.   

To calculate the limits of accuracy after specifying all desired parameters, click the Calculate 

Limits of Accuracy button. When the calculations are completed, a Results window will be brought 

into view displaying the results. The Results window can be accessed at any time by clicking the 

Results option under the View Menu or through its shortcut Ctrl+R. 

Similarly, to calculate a model image after specifying all desired parameters press the Calculate 

Model Image. A model image is an image profile that is devoid of stochasticity and noise. To 

simulate realizations of this model image, press the Simulate Data Images button. Note that the 

simulated data images are corrupted by stochasticity and noise. For instance, depending on the 
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desired set of parameters, the image can be corrupted by extraneous noise sources such as 

background, readout or stochastic signal amplification.  

Finally, clicking the MUMDesignTool option under the Tools Menu or hitting Ctrl+M calls the 

MUMDesignTool application which will be discussed in detail later in this tutorial.  

Before you begin 

Before following this tutorial, please make sure that the software has been correctly installed 

and started. Please refer to the FandPLimitTool – Installation Guide for instructions on installing and 

starting the application. 

(WARNING) User defined functions 

The Advanced Inputs Window has fields where the user is required to select which function to 

use to perform a certain part of the calculation. In the options available for such fields, the “User 

Defined” option is also often available. This option allows the user to specify the names of their own 

custom function for performing the associated part of the calculation.  

However, in the executable version of the program, this option is not fully supported. Users 

cannot specify the names of their own functions for the user defined options as such functions will 

not have been compiled along with the original program to generate the executable and therefore 

will not be recognized by the executable version of the program. 
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1. 2D-localization accuracy measure 

This section provides an example of how to use the FandPLimitTool to calculate the accuracy 

with which the 2D location of an object can be estimated from its image (PLAM). The object is 

assumed to be in focus with respect to the objective lens and the image of the object is assumed to 

be an Airy profile.  

The calculation takes into account the stochastic nature of the photon detection processes and 

assumes the photons detected from the object to be Poisson distributed. In addition, the calculation 

also takes into account extraneous noise sources - in particular the background component which is 

modeled as additive Poisson noise, the readout noise of the detector which is modeled as 

independent, additive Gaussian noise and the stochastic signal amplification noise which is present 

in EMCCD detectors [3].  

It is assumed that the pixels are rectangular in shape with no dead space between any two 

pixels. Further, the region of interest (ROI) containing the image of the object is assumed to be a 

rectangular array of pixels. The object is assumed to be in the center of this rectangular pixel array 

and the location of the object is specified with respect to the object space. Refer to [2] for details on 

determining the 2D localization accuracy in single molecule microscopy. 

1.1. Summary of imaging conditions 

The following table summarizes the imaging conditions under which the calculations are 

performed. 

Property Value 

Numerical aperture 1.45 

Wavelength 0.69 μm 

Photon detection rate 10,000 photons/second 

Exposure time 0.13 seconds 

Magnification 100 X 

Location of object in ROI 0.585 μm, 0.585 μm 

Pixel size 13 μm × 13 μm 

ROI Size 9 pixels × 9 pixels  

Background level (Poisson rate) 1000 photons/pixel/second 

Gaussian noise mean 0 e
- 
 

Gaussian noise standard deviation 8 e
-
 rms 

Use EM unchecked 

EM gain 100 

EM model Geometric 
 

Table 1.1.1:  2D Localization Accuracy - Summary of imaging conditions 

 

 



 
11 2D-localization accuracy measure 

1.2. Providing required parameters 

Step 1: Select the problem scenario of “2D Localization Accuracy - Airy: Pixelated with Poisson + 

Gaussian Noise” from the Calculate pull-down menu in the main application window. 

 

 

Figure 1.2.1: Selecting the 2D Localization Accuracy calculate type 
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Step 2: The required parameters window, which is visible by default, will be updated 

accordingly. If this window is not visible, access it by clicking the Required Parameters option under 

the Parameters Menu in the main application window. 

 

Figure 1.2.2:  Required parameters window (2D Localization) 

 

Step 3: In the - Fundamental inputs - section of the window, enter the values for the various 

fields as follows: Numerical aperture = 1.45, Wavelength = 0.69, Photon detection rate = 10000, and 

Exposure time = 0.13. 

Step 4: In the - Additional inputs - section of the window, enter the values for the various fields 

as follows: Magnification = 100, x0 = 13×4.5/100, y0 = 13×4.5/100, Pixel size = [13, 13], and ROI size = 

[9, 9]. 

Remark 1: The center of a 9 pixels × 9 pixels pixel array where the dimensions of each pixel is 13 μm × 13 

μm, is (4.5 × 13)μm × (4.5 × 13)μm. To convert this location coordinates to the object space, the coordinate 

values are divided by the magnification. Hence the location coordinates are specified as 13×4.5/100 μm × 

13×4.5/100 μm. 

Step 5: In the - Extraneous noise sources - section of the window, enter the values for the 

various fields as follows: Background level = 1000 and Standard deviation = 8. 
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Remark 2: In case that the localization accuracy is required for an EMCCD detector, the Use EM checkbox 

should be checked and the desired value for the electron multiplication gain should entered in the EM gain 

field. The default electron multiplication model is Geometric. However, different electron multiplication 

models, e.g. High gain and Gaussian, can be chosen from the EM model combo box based on the requirements. 

By holding the mouse pointer on the EM model combo box, a brief description of each option is shown on a 

tool tip text. For more information about different electron multiplication models consult [3].    

      

 

Figure 1.2.3: Electron multiplication parameters 

 

Step 6: In the - Parameters to be estimated - section of the window, ensure that all check- boxes 

for all parameters are checked. 

Step 7: To improve screen clarity, close the Required parameters window.  

Remark 3: Closing the window is not in any way required by the application for the calculations to be 

performed and is only a suggestion in order to reduce the number of open windows and hence improve 

screen clarity. You can access the window again at any time by clicking the Required Parameters option 

under the Parameters Menu in the main application window. 

 

1.3. Providing advanced parameters 

NOTE: All inputs in the Advanced Parameters window are optional. The default values provided have 

been found to work adequately for typical imaging conditions.  

Step 1: Access the advanced parameters window by clicking the Advanced Parameters option 

under the Parameters Menu in the main window. 
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Figure 1.3.1:  Advanced parameters window (2D Localization) 

 

Step 2: In the - Model profile calculations - section of window, access the Pixel integration 

method pull-down menu and select “Trapezoidal”. 

Step 3: Click the Additional parameters button next to the Pixel integration method pull-down 

menu. In the dialog box that appears, enter values for fields as follows: XGridding = 13, YGridding = 

13. Click OK when done. 

 

 

Figure 1.3.2:  Pixel Integration Trapezoidal options 

 

Step 4: Access the Background type pull-down menu and select “Constant”. There are no 

additional parameters to be accessed via the Additional parameters button for the “Constant” option. 

Step 5: In the - Fisher information matrix calculations - section of the window, access the Single 

integration method and select “Trapezoidal”. 

Step 6: Click on the Additional parameters button next to the Single integration method pull-

down menu. In the dialog box that appears, enter Step size = 0.05. 
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Figure 1.3.3:  FIM Single Integration Trapezoidal options 

 

Step 7: Access the Double integration method pull-down menu in the - Fisher information 

matrix calculations - section of the window and select “Trapezoidal”. 

 

 

Figure 1.3.4:  FIM Double Integration Trapezoidal options 

 

Step 8: Click on the Additional parameters button next to the Double integration method pull-

down menu. In the dialog box that appears, enter the values XGridding = 13 and YGridding = 13. 

Step 9: The - Fisher information matrix calculations - section has a subsection titled - Noise 

factor calculation parameters - . Enter values Limits of summation = [1, 3000] and Limits of 

integration = [-5000, 5000] in this subsection. 

Remark 4: The limits of integration and summation are initially set to default values which are 

automatically calculated based on the imaging conditions. It is possible specify these limits by changing the 

value of the combo box to the right of the limits of integration and summation fields.  

 

  

Figure 1.3.5: Noise factor calculation parameters 

 

Step 10: To improve screen clarity, close the Advanced parameters window. 
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Remark 5: Closing the window is not in any way required by the application for the calculations to be 

performed and is only a suggestion in order to reduce the number of open windows and hence improve 

screen clarity. You can access the window again at any time by clicking the Advanced Parameters option 

under the Parameters Menu in the main application window. 

 

1.4. Viewing and saving the parameter summary 

NOTE: This is a new feature of the FandPlimitTool V1.2. Typically it is necessary to save the required and 

advanced parameters for later developments and to keep track of calculations. This new feature provides a 

summary of the required and advanced parameters in a plane text format.  

Step 1: Access the required inputs summary window by hitting the Parameter Summary option 

under View Menu. 

 

Figure 1.4.1:  Viewing and saving the parameter summary (2D Localization) 

Step 2: You will see the summary of the required and advanced parameters in a plane text 

format. This summary can be saved on the disc as a .txt file by hitting the Save as text button. 

 

1.5. Executing the task and viewing results 

Step 1: In the main application window, click the Calculate Limits of Accuracy button. This will 

present a dialog box warning that the calculation may take a long time to complete. Click Yes to 

proceed. The Calculate button text will change to Calculating … and the application will temporarily 

become unresponsive while the calculations are being performed. During the calculation, a console 
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window will be shown to inform the user about the different steps of the calculation. This console 

window will also display errors and warnings, if there is any, which is very useful for bug reporting 

purposes.  

NOTE: The calculation could indeed take half an hour to complete depending on the hardware capabilities 

of the platform on which the application is being executed. 

 

Figure 1.5.1:  Calculation and Final confirmation 

 

Step 2: When the calculation is completed, the Calculating … button text will change back to 

Calculate Limits of Accuracy and the Results window will be brought in focus. In addition, the 

console window will be hidden when the calculation is over. The console window can be accessed 

any time by selecting the Console option under the View Menu.  

 

Figure 1.5.2:  2D localization accuracy Results window 
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2. Varying a parameter (multivalue mode) 

Multivalue Mode is a new functionality designed for the calculation and visualization of the 

fundamental and practical limits on the 2D and 3D localization accuracy and resolution for a range 

of parameter values. This section provides an example of how to use the Multivalue Mode to 

calculate the 2D PLAM for a range of an input parameter. We assume that user has applied all the 

steps in Section 1 (2D-Localization Accuracy Limit). 

 

2.1. Providing inputs for the multivalue mode 

Step 1: Access the multivalue mode window by toggling the Vary a Parameter button at the 

bottom of the Required Parameters window. 

 

Figure 2.1.1:  Multivalue Mode setting window 

 

Step 2: In the – Multivalue parameter - section of window, access the Parameter pull-down 

menu and select “Photon detection rate”. 

Step 3: In the Values field, enter 100:100:1000. This will automatically define a vector 

containing [100 200 300 400 500 600 700 800 900 1000].  

Step 4: check the Auto-center image for each calculation checkbox. This will automatically 

center the particle in the ROI. 

Step 5: In the main application window, click the Calculate Limits of Accuracy button. This will 

present a dialog box warning that the calculation may take a long time to complete. Click Yes to 

proceed. The Calculate Limits of Accuracy button text will change to Calculating … and the application 

will temporarily become unresponsive while the calculations are being performed. In addition the 

console window will become visible. 

NOTE: The calculation could indeed take a couple of hours to complete depending on the number of data 

points and hardware capabilities of the platform on which the application is being executed. 



 
19 Varying a parameter (multivalue mode) 

Step 6: When the calculation is completed, the Calculating … button text will change back to 

Calculate Limits of Accuracy. 

NOTE: Steps 5 and 6 are explained in more details in Section 1.5 (Executing the task and viewing results). 

 

2.2. Plotting the limit of accuracy versus a parameter value 

Step 1: In the Multivalue Mode window, click the Plot button. This will open the Multivalue 

Plot Window shown in the following figure. 

 

 

Figure 2.2.1:  Multivalue results and plot windows 

 

Step 2: In the Multivalue Plot window, access the Select Plot pull-down menu and select “Limit 

of accuracy of x0 vs Photon detection rate”. A plot of the limit of accuracy of x0 versus the photon 

detection rate will be shown as illustrated in the above figure.  

Step 3: In the Multivalue Mode window, click the Results button. This will open the Multivalue 

Results Window shown in the above figure. The selected values for the parameter will then be 

shown in a list box. Clicking different lines of this list box will show the corresponding results in the 

Results Window.  
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3. Simulating and visualizing model and data images  

Another new feature of the FandPLimitTool V1.2 is that user can now simulate and visualize 

model and data images of a single molecule associated with a desired problem scenario and a 

specific set of parameters. A model image is in fact the image profile of a single molecule (or two 

single molecules in case of a resolution problem) in the absence of stochasticity and extraneous 

noise. A simulated data image, on the other hand, is a realization of a model image and is corrupted 

by stochasticity and extraneous noise sources such as background, readout and stochastic signal 

amplification. The following sections provide examples for calculating and visualizing model and 

data images, respectively. We assume that user has applied all the steps in Section 1 (2D-

Localization Accuracy Limit). 

 

3.1. Calculate a model image  

NOTE: For some of the problem scenarios (mostly fundamental limits), a model image may not be 

available. In such cases, the Calculate Model Image button will be grayed out and as such a model image 

cannot be calculated. 

 

 

Figure 3.1.1: Unavailable model and data images 

 

Step 1: If a model image is available for current problem scenario, in the main application 

window, click the Calculate Model Image button. The Calculate Model Image button text will change 

to Calculating Model Image … and the application will temporarily become unresponsive while the 

calculations are being performed. 
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Figure 3.1.2:  Calculate a model image 

 

Step 2: When the calculation is completed, the Calculating Model Image … button text will change 

back to Calculate Model Image and the display tool will be brought in focus. 

 

Figure 3.1.3:  Model image viewer 

Step 3: In the viewer window, you can visualize the model image and change the visual effects. 
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NOTE: The viewer belongs to our previously developed Microscopy Image Analysis Tool (MIATool). For 

more information please see [4]. 

Remark 6: In case that the Show Model functionality is used together with the Multivalue Mode, the 

viewer will show a stack of images associated with the different values of the Multivalued parameter. In this 

case, user can visualize the different model images by scrolling the slider to the left in the Viewer Slider 

window, as shown below. The current value of the parameter (e.g. Magnification = 150) will also be shown in 

the viewer window (see below).  

 

Figure 3.1.4: Model image viewer in Multivalue Mode 

 

Step 4: To improve screen clarity, close the Model Image Viewer using the standard exit 

buttons on any of the viewer windows. 

 

3.2. Simulate data images  

NOTE: For some of the problem scenarios (mostly fundamental limits), a data image may not be available. 

In such cases, the Simulate Data Images button will be grayed out and as such a data image cannot be 

simulated (this is shown in Figure 3.1.1). 

Step 1: If a data image is available for current problem scenario, in the main application window, 

click the Simulate Data Images button. This will present a dialog box to enter the desired number of 

data images (i.e. realizations) of current model. 
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Figure 3.2.1: Enter the number of data images 

 

Step 2: Enter the desired number of data images. Click OK to proceed. The Simulate Data Images 

button text will change to Simulating X Data Images …, where X is the number of desired images 

specified by user. The application will temporarily become unresponsive while the calculations are 

being performed. 

 

 

Figure 3.2.2: Simulating data images 

 

Step 3: When the calculation is completed, the Simulating X Data Images … button text will change 

back to Simulate Data Images and the display tool will be brought in focus. 

Step 4: In the viewer window, you can visualize the data images and change the visual effects. 
You can also visualize different realization by scrolling the slider to the right in the Viewer Slider window. 

NOTE: The viewer belongs to our previously developed Microscopy Image Analysis Tool (MIATool). For 

more information please see [4]. 

Remark 7: In case that the Simulate Data Images functionality is used together with the Multivalue 

Mode, the viewer will show a stack of data images associated with the different values of the Multivalued 

parameter. In this case, user can visualize images that correspond to different model by scrolling the slider to 
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the left in the Viewer Slider window, as shown below. On the other hand, different realizations (data 

images) of a specific model can be accessed using the slider to the right (see below). 

 

 

Figure 3.2.3: Simulated image viewer in Multivalue Mode 
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4. Saving and loading the settings 

User can conveniently save and load the software settings which include the current problem 

scenario, required and advanced parameters, etc., into and from the disk, respectively. This 

functionality is useful for retrieving the adjustments and results of a specific calculation after 

closing and reopening the software. We next briefly describe how to make use of this important 

functionality.   

 

4.1. Saving the settings 

Step 1: To save the settings, click the Save Settings option under the File Menu or use the shortcut 

Ctrl+S (see below). This will present a dialog box to enter a file name. The file extension is .fim. 

Enter your desired name and click Save. 

 

 

Figure 4.1.1: Saving and loading the settings 

 

4.2. Loading the settings 

Step 1: To load the settings, click the Load Settings option under the File Menu or use the shortcut 

Ctrl+L (see Figure 4.1.1). This will present a dialog box to choose the desired file with extension 

.fim. Select a previously saved setting and press Open. 
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5. Exporting results, parameters, images and report 

The FandPLimitTool V1.2 provides very flexible tools for exporting the results of calculations, 

simulated images and even a report file. More specifically, user can export the results and 

parameters of a desired problem scenario, the simulated model and data images and a LeTex report 

that can be generated when performing a multivale calculation (i.e. when varying a parameter). The 

simulated model and data images can also be exported when varying a parameter. In such cases, a 

sequence of images will be exported. In this section, we discuss different steps of exporting various 

results.   

 

5.1. Exporting the results and parameters 

NOTE: To export the desired outputs such as results, images and a report, appropriate calculations has to 

be performed prior to exporting. If the results, model and data images and a LeTex report are not available, 

the corresponding menu options under the Export Menu will be grayed out (see below). After the 

appropriate calculation is performed the corresponding menu option becomes accessible. 

 

 

Figure 5.1.1: Exporting is not available 

 

Step 1: Perform either a standard (see e.g. Section 1) or a multivalue (see Section 2) calculation 

for the limits of accuracy. Once the calculation is performed and the results are available within the 

software, the Results and Parameters option under the Export Menu becomes accessible.  

Step 2: Select the Results and Parameters option under the Export Menu (see figure below). This 

will present a folder browser. 

Step 3: Select a folder name in which you would like to save the results and parameters and click 

OK. The results and parameters will be saved as two independent text files in the specified folder. 
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Figure 5.1.2: Exporting the results and parameters 

 

NOTE: Depending on the type of calculation (i.e. singlevalue and multivalue), the exported results text file 

may include one value or multiple values for the limit of accuracy of each parameter. An example for the 

exported text file for a multivalue calculation is shown below.  

 

 

  Figure 5.1.3: An example for the exported results and parameters 
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5.2. Exporting the model and data images 

Step 1: Exporting the model images is available upon performing at least one of the three 

different actions which are the calculation of the limits of accuracy (see e.g. Section 1), the 

calculation of a model image (see Section 3.1) and the simulation of data images (see Section 3.2). 

On the other hand, both model and data images can be exported only after simulating data images. 

Once one of the mentioned calculations is performed, the Model and Data Images option under the 

Export Menu becomes accessible.  

Step 2: Select the Model and Data Images option under the Export Menu (see figure below). This 

will present a folder browser. 

Step 3: Select a folder name in which you would like to save the simulated model and data 

images and click OK. The model and data images will be saved within two separate folders under 

the specified folder. 

NOTE: Depending on the type of calculation (i.e. singlevalue or multivalue), the exported model and data 

image folders may contain a sequence of images. 

 

 

  Figure 5.2.1: Exporting the model and data images 

 

5.3. Exporting a LeTex report 

NOTE: A LeTex report can be generated only after performing a multivale calculation (i.e. 

calculating the limits of accuracy when varying a parameter).  
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Step 1: Perform a multivalue calculation for the limits of accuracy (see Section 2). Once the 

calculation is performed and the results are available within the software, the LeTex Report option 

under the Export Menu becomes accessible. 

Step 2: Select the LeTex Report option under the Export Menu (see figure below). This will 

present a folder browser. 

 

  Figure 5.3.1: Exporting a LaTex report 

 

Step 3: Select a folder in which you would like to save the LaTex report and click OK. A .tex file 

together with several .eps images will be saved within a folder named LaTex Report under the 

specified folder. 

 

5.4. Exporting everything simultaneously 

NOTE: If all the required calculations are performed, the export All... option becomes available and user 

can export everything simultaneously.  

Step 1: Select the All… option under the Export Menu. This will present a folder browser. 

Step 2: Select a folder name in which you would like to export all the results including the limits 

of accuracy, the simulated model and data images and the LaTex report, and then click OK. 
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6. Console window, log file and bug reporting 

The FandPLimitTool V1.2 is equipped with a new console window and a log file. The console 

window, which can be accessed directly within the software, not only can provide users with the 

details of calculations in real-time, but also is very useful for identifying warning, errors and 

reporting bugs. The information that are shown in the console window are also stored in a log file.    

 

6.1. The console window 

As mentioned earlier, during the long calculations a console window is automatically displayed 

to inform the user about different steps of the calculation. This console window can also display 

errors and warnings, if there is any, which is very useful for bug reporting purposes. 

Step 1: To access the console window at any time, select the Console option under the View 

Menu. 

Step 2: To hide the console window, simply close it using the standard close button. Note that 

closing the console window will not stop storing the information in the log file. 

 

 

Figure 6.1.1: Console window 

 

6.2. The log file and bug reporting 

The information that are displayed in the console window are also stored in a log file 

“fandp_log.mia” in the following path:  
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C:\Users\{username}\AppData\Roaming\FandPLimitTool 

 

 

Figure 6.2.1: Log file 

 

To report a bug (that leads to an error or warning), please send this log file to us. More 

information about the current versions of the FandPLimitTool and the MUMDesignTool, their 

homepages and licensing can be found in the corresponding About windows (e.g. see below). 

 

 

Figure 6.2.2: About the FandPLimitTool 
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7. The MUMDesignTool 

This section describes how to use the MUMDesignTool, a new software module in the new 

version of the FandPLimitTool, to calculate and plot the Fisher information matrix (FIM) and the 

PLAM [1] along the z-axis. The MUMDesignTool is developed to help in designing the plane spacing 

for a multifocal plane microscopy (MUM) setup including up to 10 focal planes. 

The MUMDesignTool provides two working modes. The Rapid Mode takes into account the 

stochastic nature of the photon detection processes and assumes that the observed data is Poisson 

distributed [1]. However, this mode does not take into consideration other extraneous noise 

sources such as the background, readout and stochastic signal amplification. This mode yields a fast 

approach for the calculation of the FIM and the PLAM, and allows changing the number of focal 

planes and their spacings in real-time. In addition, the Precise Mode takes into account the 

extraneous noise sources, such as the background noise which is independently Poisson 

distributed, the readout noise which is modeled as independent additive Gaussian noise [2], and in 

case of using an EMCCD detector, the stochastic electron multiplication noise that is modeled as a 

branching process [3]. 

It is assumed that the pixels are rectangular in shape with no dead space between any two 

pixels. Further, the ROIs containing the images of the object are assumed to be rectangular arrays of 

pixels. The object is assumed to be in the center of this rectangular pixel array and the location of 

the object is specified with respect to the object space. Refer to [1] for more details regarding the 

design of focal plane spacing for a MUM setup. 

 

7.1. Summary of simulation conditions 

The following table summarizes the imaging conditions under which the calculations are 

performed. 

Property Value 

Number of focal planes 2 

Photon detection rate 10,000 photons/second 

Photon count percentage [50, 50] % 

Object medium refractive index 1.515 

Numerical aperture 1.45 

Wavelength 0.69 μm 

Exposure time 0.1 seconds 

Magnification 100 X 

Location of object in ROI 0.585 μm, 0.585 μm 

Pixel size 13 μm × 13 μm 

ROI Size 9 pixels × 9 pixels  

Defocus start -2 μm 

Defocus increment 0.05 μm 

Defocus end 2 μm 
 

Table 7.1.1: Summary of simulation parameters for the MUMDesignTool 
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7.2. Providing the inputs and configuring the MUMDesignTool 

Step 1: Access the Configure Setting – MUM Design Tool window by clicking the 

MUMDesignTool option under Tools Menu in the main application window or through its shortcut 

Ctrl+M. 

 

 

Figure 7.2.1: The MUMDesignTool configuration window 

 

Step 2: In the – Simulation parameters - section of the window, enter the values for the various 

fields as follows: Number of focal planes = 2, Total photon count = 10000, Photon count percentage = 

[50, 50], Immersion medium refractive index = 1.515, Numerical aperture = 1.45, Wavelength = 0.69, 

Exposure time = 0.1, Magnification = 100, x0 = 13×4.5/100, y0 = 13×4.5/100, Pixel size = [13, 13], and 

ROI size = [9, 9]. 

Note: The center of a 9 pixels × 9 pixels pixel array where the dimensions of each pixel is 13 μm × 13 μm, is 

(4.5 × 13)μm × (4.5 × 13)μm. To convert this location coordinates to the object space, the coordinate values 

are divided by the magnification. Hence the location coordinates are specified as 13×4.5/100 μm × 13×4.5/100 

μm. 

Step 3: In the – Defocus range - section of the window, enter the values for the various fields as 

follows: Defocus start = -2, Defocus increment = 0.05, Defocus end = 2. 

Step 4: In the configure setting – MUM Design Tool window, click the Done button. The Done 

button text will change to Calculation in progress … and the application will temporarily become 
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unresponsive while the calculations are being performed. During the calculation, a console window 

will be shown to inform the user about the different steps of the calculation. This console window 

will also display errors and warnings, if there is any, which is very useful for bug reporting 

purposes.  

NOTE: The calculation could indeed take half an hour to complete depending on the hardware capabilities 

of the platform on which the application is being executed. 

 

Figure 7.2.2:  MUMDesignTool calculation in progress 

 

Step 5: When the calculation is completed, the MUMDesignTool (Rapid Mode) window will be 

brought in focus (more details about this window will be discussed in the next section). 

 

7.3. Designing the plane spacing using the Rapid Mode 

Figure 7.3.1 shows the main window of the MUMDesignTool. The – Simulation summary - 

section of the window represents a summary of the simulation parameters. The – Focal plane offset 

- section of the window includes a pull-down menu for selecting the number of focal planes as well 

as 10 slides to change the plane spacings. Note that these settings can be performed in real-time. 

The right-hand side panels, which show the FIM and PLAM along the z-axis for the MUM setup, will 

be updated automatically by changing the plane spacing and other parameters. 

The – PDR – section of the window assists us with choosing the total photon detection rate of the 

setup as well as the photon percentage for each focal plane. Changing the number of planes will 

automatically update the photon percentages to be consistent with the total photon detection rate.  
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The – Display options – section of the window provides controls for better calculation and 

visualization of the FIM and PLAM, and also provides tools for exporting the results. For instance, 

using radio buttons z0, x0 and y0, user can switch the FIM and PLAM plots to visualize the behavior 

of the corresponding coordinate along the z-axis. The embedded checkboxes help to hide or show 

different curves within the figures and enhance the visibility. Moreover, a desired region in the plot 

can be highlighted using other controls in this panel.  

The Reset button in this panel resets the MUMDesignTool by recalling the Configure Setting – 

MUMDesignTool Window. The Split windows button shows the FIM and PLAM plots in new 

decoupled windows. Also, the Export button exports both the results as .txt files and the plots as .pdf 

files. Finally, the Precise Mode button runs the precise mode calculation of the MUMDesignTool to 

provide accurate results for the behavior of the FIM and PLAM curves (This function will be 

discussed in detail later). 

We next give an example for designing the focal plane spacing for a 3-plane MUM setup using the 

strong coupling spacing scenario (for more information see [1]). We assume that user has applied 

the steps in Section 7.2 (Providing the inputs and configuring the MUMDesignTool). Here are the 

steps:      

 

 

Figure 7.3.1:  MUMDesignTool Rapid Mode (main window) 
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Step 1: In the – Focal plane offset - section of the window select “3” from the Number of focal 

planes pull-down menu. 

 

 

Figure 7.3.2:  Changing the number of focal planes in real-time 

 

Step 2: You will see an alert stating that “Photon count percentages have been reset”. Click OK to 

proceed.  

 Step 3: In the – Focal plane offset - section of the window set the value of the plane spacing 

slider 2 to be equal to “0.6 microns”. Also, set the value of the plane spacing slider 3 to be equal to 

“1.2 microns”. This will overlap the zero of the z0-FIM of each focal plane with the local maximum of 

that of the adjacent focal plane (for more information see [1]). As a result, the FIM and PLAM curves 

will be updated. 

Step 4: In the – Display options - section of the window, select “Sum line” from the View mode 

pull-down menu. This will update the FIM such that only the sum line data points will be visible.  

Step 5: In the – Display options - section of the window, change the right-hand side field of 

Highlight region to “0.6” and check the “Show” checkbox. This will highlight the region between 

plane 1 and plane 2 for better visualization.  

Step 6: In the – Limit ruler - section of the window, set the z0 slider to 19 nm. At this step, you 

will see the z0 elements of the FIM and PLAM curves. 

Step 7: To see the x0 elements of the FIM and PLAM curves, in the – Display options – section, 

select the x0 radio button. The FIM and PLAM curves will be updated accordingly as can be seen in 

the following figure. 
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Figure 7.3.3:  The lateral elements of FIM and PLAM (MUMDesignTool Rapid Mode) 

 

Step 8: To save the calculated data points and the plots click the Export button in the – Display 

options – section. You will be asked to select a folder. 

 

 

Figure 7.3.4:  Exporting the MUMDesignTool results 
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Step 9: In the Browse For Folder window, select a folder and click the OK button. This will 

export the results as text files and the plots as pdf files. 

 

7.4. Precise Mode 

Once user has designed the plane spacing using the Rapid Mode, the next step is to verify 

whether the designed spacing is appropriate in the presence of extraneous noise sources. This 

verification is performed using the Precise Mode of the MUMDesignTool. We next provide an 

example for this verification step. 

Step 1: Click the Precise Mode button in the – Display options – section to calculate the accurate 

FIM and PLAMs along the z-axis considering the extraneous noise parameters. This will load the 

Noise Parameter Setting (Precise Mode) window as shown below.  

 

 

Figure 7.4.1:  Entering the noise parameters 

 

Step 2: In Noise Parameter Setting (Precise Mode) window, select the “Poisson + Gaussian + 

Branching” option in the Noise Type drop down menu. This will consider background, readout and 

branching noise for the calculations. This option is suitable when using an EMCCD detector.  

NOTE: Holding the mouse pointer on this drop down menu will give a brief explanation (as a tool tip text) 

about the suitable option for different types of detectors (see Figure 7.4.1). 

Step 3: Enter the values Background noise = [35 60 85], the Readout noise std = [8 5 7], the EM 

gain = [250 100 110] and the EM model = [1 1 1]. Click OK when done. The Precise Mode button text 

will change to Calculating … and the application will temporarily become unresponsive while the 

calculations are being performed (see figure below). The console window will also be displayed. 

NOTE: The calculation could indeed take an hour to complete depending on the hardware capabilities of 

the platform on which the application is being executed. 
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Figure 7.4.2:  Calculation procedure in the Precise Mode 

 

Remark 8: Each element in the Background noise, Readout noise std, EM gain and EM model vectors 

corresponds to one of the focal planes. For example, in the above case, the vectors have 3 elements associated 

with the 3 focal planes. For more information about the different EM models see [3]. 

Step 4: When the calculation is completed, the Calculating … button text will change back to 

Precise Mode and the MUMDesignTool (Precise Mode) window will be brought in focus (see 

figure below). 

 

Figure 7.4.3:  MUMDesignTool Precise Mode 
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8. 3D-Localization accuracy measure (Born-Wolf Model) 

This section provides an example of how to use the FandPLimitTool to calculate the accuracy 

with which the 3D location of an object can be estimated from its image (PLAM). The image of the 

object is assumed to be a 3D Point Spread Function profile. 

The calculation takes into account the stochastic nature of the photon detection processes and 

assumes the photons detected from the object to be Poisson distributed. In addition, the calculation 

also takes into account extraneous noise sources - in particular the background component which is 

modeled as Poisson noise [1], the readout noise of the detector which is modeled as independent, 

additive Gaussian noise [2] and the electron multiplication noise of an EMCCD detector which is 

modeled as a branching process [3]. 

It is assumed that the pixels are rectangular in shape with no dead space between any two 

pixels. Further, the ROI containing the image of the object is assumed to be a rectangular array of 

pixels. The object is assumed to be in the center of this rectangular pixel array and the location of 

the object is specified with respect to the object space. 

Refer to [5] for details on determining the 3D localization accuracy in single molecule 

microscopy. 

 

8.1. Summary of imaging conditions 

The following table summarizes the imaging conditions under which the calculations are 

performed. 

Property Value 

Z0 0.5 μm 

Object medium refractive index 1.515 

Numerical aperture 1.3 

Wavelength 0.52 μm 

Photon detection rate 10,000 photons/second 

Exposure time 0.13 seconds 

Magnification 100 X 

Location of object in ROI 0.585 μm, 0.585 μm 

Pixel size 13 μm × 13 μm 

ROI Size 9 pixels × 9 pixels  

Background level (Poisson rate) 1000 photons/pixel/second 

Gaussian noise mean 0 e
-
 

Gaussian noise standard deviation 8 e
-
 rms 

Use EM unchecked 

EM gain 100 

EM model Geometric 
 

Table 8.1.1:  3D Localization Accuracy - Summary of imaging conditions 
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8.2. Providing required parameters 

Step 1: Select the calculation option “3D Localization Accuracy - Airy: Pixelated with Poisson + 

Gaussian Noise” from the Calculate pull-down menu in the main application window. 

Step 2: The required parameters window should be visible by default. If it is not visible, access it 

by clicking the Required Parameters option under the Parameters Menu. 

 

 

Figure 8.2.1: 3D Localization Accuracy problem scenario and its required parameters window 

 

Step 3: In the - Fundamental inputs - section of the window, enter the values for the various 

fields as follows: z0 = 0.5, Object medium refractive index = 1.515, Numerical aperture = 1.3, 

Wavelength = 0.52, Photon detection rate = 10000, and Exposure time = 0.13. 

Step 4: In the - Additional inputs - section of the window enter the values for the various fields 

as follows: Magnification = 100, x0 = 13×4.5/100, y0 = 13×4.5/100, Pixel size = [13, 13], and ROI size = 

[9, 9]. 

Remark 9: The center of a 9 pixels × 9 pixels pixel array where the dimensions of each pixel is 13 μm × 13 

μm, is (4.5 × 13)μm × (4.5 × 13)μm. To convert this location coordinates to the object space, the coordinate 
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values are divided by the magnification. Hence the location coordinates are specified as 13×4.5/100 μm × 

13×4.5/100 μm. 

Step 5: In the - Extraneous noise sources - section of the window, enter the values for the 

various fields as follows: Background level = 1000 and Standard deviation = 8. 

Remark 10: In case that the localization accuracy is required for an EMCCD detector, the Use EM checkbox 

should be checked and the desired value for the electron multiplication gain should entered in the EM gain 

field. For more information see Remark 2. 

Step 6: In the - Parameters to be estimated - section of the window, ensure that all check-boxes 

for all parameters are checked. 

 

8.3. Providing advanced parameters 

NOTE: All inputs in the Advanced Parameters window are optional. The default values provided have 

been found to work adequately for typical imaging conditions. 

Step 1: Access the advanced parameters window by clicking the Advanced Parameters option 

under the Parameters Menu. 

 

Figure 8.3.1: 3D Localization Accuracy advanced parameters window 

 

Step 2: The Advanced parameters window contains an - Advanced fundamental inputs - section. 

The default value of the field in this section can be left unchanged. 
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Step 3: In the - Model profile calculations - section of the window, access the Pixel integration 

method pull-down menu and select “Trapezoidal”. 

 

Figure 8.3.2:  Pixel Integration Trapezoidal options 

 

Step 4: Click the Additional parameters button next to the Pixel integration method pull-down 

menu. In the dialog box that appears, enter the values XGridding = 13 and YGridding = 13. Click OK 

when done. 

Step 5: Access the Model integration method pull-down menu in the same section of the window 

and select “Trapezoidal”. 

 

Figure 8.3.3:  Model Integration Trapezoidal options 

 

Step 6: Click the Additional parameters button next to the Model integration method pull-down 

menu. In the dialog box that appears, enter the values Step size = 0.0005, Lower limit = 0, and Upper 

limit = 1. Click OK when done. 

Step 7: Access the Background type pull-down menu and select “Constant”. There are no 

additional parameters to be accessed via the Additional parameters button for the “Constant” 

option. 

Step 8: In the - Fisher information matrix calculations - section of the window, access the Single 

integration method pull-down menu and select “Trapezoidal”. 
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Figure 8.3.4:  FIM Single Integration Trapezoidal options 

 

Step 9: Click the Additional parameters button next to the Single integration method pull- down 

menu. In the dialog box that appears, enter the values Step size = 0.0005, Lower limit = 0, and Upper 

limit = 1. Click OK when done. 

Step 10: Access the Double integration method pull-down menu in the same section of the 

window and select “Trapezoidal”. 

 

Figure 8.3.5:  FIM Double Integration Trapezoidal options 

 

Step 11: Click on the Additional parameters button next to the Double integration method pull-

down menu. In the dialog box that appears, enter the values XGridding = 13 and YGridding = 13. 

Step 12: The - Fisher information matrix calculations - section has a subsection titled - Noise 

factor calculation parameters - . Enter the following values in this subsection: Limits of summation = 

[1, 3000], Limits of integration = [-5000, 5000] and Trapezoidal integration step size = 0.05. 

Remark 11: The limits of integration and summation are initially set to default values which are 

automatically calculated based on the imaging conditions. It is possible specify these limits by changing the 

value of the combo box to the right of the limits of integration and summation fields.  
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8.4. Executing the task and viewing results 

Step 1: In the main application window, click the Calculate Limits of Accuracy button. This will 

present a dialog box warning that the calculation may take a long time to complete. Click Yes to 

proceed. The Calculate button text will change to Calculating … and the application will temporarily 

become unresponsive while the calculations are being performed. During the calculation, a console 

window will be shown to inform the user about the different steps of the calculation. 

NOTE: The calculation could indeed take half an hour to complete depending on the hardware capabilities 

of the platform on which the application is being executed. 

 

 

Figure 8.4.1:  Calculation and Final confirmation 

 

Step 2: When the calculation is completed, the Calculating … button text will change back to 

Calculate Limits of Accuracy and the Results window will be brought in focus. In addition, the 

console window will be hidden when the calculation is over. The console window can be accessed 

any time by selecting the Console option under the View Menu.  
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Figure 8.4.2:  3D localization Accuracy results window 
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9. 2D-Resolution measure 

This section provides an example of how to use the FandPLimitTool to calculate the accuracy 

with which the 2D location of two objects can be resolved from their image (PREM). The objects are 

assumed to be in focus with respect to the objective lens and the image of each object is assumed to 

be an Airy profile. 

The calculation takes into account the stochastic nature of the photon detection processes and 

assumes the photons detected from the object to be Poisson distributed. In addition, the calculation 

also takes into account extraneous noise sources - in particular the background component which is 

modeled as additive Poisson noise, the readout noise of the detector which is modeled as 

independent, additive Gaussian noise [2] and the electron multiplication noise of an EMCCD 

detector which is modeled as a branching process [3]. 

It is assumed that the pixels are rectangular in shape with no dead space between any two 

pixels. Further, the ROI containing the image of the objects is assumed to be a rectangular array of 

pixels. The midpoint between the objects is assumed to be at the center of this rectangular pixel 

array and the location of the midpoint between the objects is specified with respect to the object 

space. 

Refer to [6] for details or determining the 2D resolution accuracy in single molecule microscopy. 

 

9.1. Summary of imaging conditions 

The following table summarizes the imaging conditions under which the calculations are 

performed. 

Property Object 1 Object 2 

Numerical aperture 1.3 1.3 

Wavelength 0.52 μm 0.52 μm 

Photon detection rate 10,000 photons/second 10,000 photons/second 

d 0.1 μm 

phi π/4 radians 

Exposure time 0.13 seconds 

Magnification 100 X 

Location of object in ROI 0.585 μm, 0.585 μm 

Pixel size 13 μm × 13 μm 

ROI Size 9 pixels × 9 pixels  

Background level (Poisson rate) 1000 photons/pixel/second 1000 photons/pixel/second 

Gaussian noise mean 0 e
-
 

Gaussian noise standard deviation 8 e
-
 rms 

Use EM unchecked 

EM gain 100 

EM model Geometric 
 

Table 9.1.1: 2D Resolution Accuracy - Summary of imaging conditions 
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9.2. Providing required parameters 

Step 1: Select the calculation option “2D Resolution Accuracy - Airy: Pixelated with Poisson + 

Gaussian Noise (Symmetric Parameterization)” from the Calculate pull-down menu in the main 

application window. 

 

 

Figure 9.2.1: 2D Resolution Accuracy calculate type and its required parameters window 

 

Step 2: The required parameters window, which is visible by default, will be updated 

accordingly. If this window is not visible, access it by clicking the Required Parameters option under 

the Parameters Menu in the main application window. 

Step 3: In the - Object selection - section of the Required parameters window, select “Object 

1”. 

Step 4: In the - Fundamental inputs – Object 1 - section of the window, enter the values for the 

various fields as follows: Numerical aperture = 1.3, Wavelength = 0.52, Photon detection rate = 

10000, d = 0.1, phi = pi/4 and Exposure time = 0.13. 
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Step 5: In the - Additional inputs - section of the window, enter the values for the various fields 

as follows: Magnification = 100, sx = 13×4.5/100, sy = 13×4.5/100, Pixel size = [13, 13], and ROI size = 

[9, 9]. 

Remark 12: The center of a 9 pixels × 9 pixels pixel array where the dimensions of each pixel is 13 μm × 13 

μm, is (4.5 × 13)μm × (4.5 × 13)μm. To convert this location coordinates to the object space, the coordinate 

values are divided by the magnification. Hence the location coordinates are specified as 13×4.5/100 μm × 

13×4.5/100 μm. 

Step 6: In the - Extraneous noise sources – Object 1 - section of the window, enter the values for 

the various fields as follows: Background level = 1000 and Standard deviation = 8. 

Remark 13: In case that the localization accuracy is required for an EMCCD detector, the Use EM checkbox 

should be checked and the desired value for the electron multiplication gain should entered in the EM gain 

field. For more information see Remark 2. 

Step 7: In the - Object selection - section of the Required parameters window, select “Object 

2”. Then repeat steps 4 and 6 for the Object 2. 

Step 8: In the - Parameters to be estimated - section of the window, ensure that all check-boxes 

for all parameters are checked. 

 

9.3. Providing advanced parameters 

NOTE: All inputs in the Advanced Parameters window are optional. The default values provided have 

been found to work adequately for typical imaging conditions. 

Step 1: Access the advanced parameters window by clicking the Advanced Parameters option 

under the Parameters Menu. 

 

 

Figure 9.3.1:  2D Resolution Accuracy advanced parameters window 
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Step 2: In the - Model profile calculations - section of window, access the Pixel integration 

method pull-down menu and select “Trapezoidal”. 

 

 

Figure 9.3.2:  Pixel Integration Trapezoidal options 

 

Step 3: Click the Additional parameters button next to the Pixel integration method pull-down 

menu. In the dialog box that appears, enter values for fields as follows: XGridding = 13, YGridding = 

13. Click OK when done. 

Step 4: Access the Background type pull-down menu and select “Constant”. There are no 

additional parameters to be accessed via the Additional parameters button for the “Constant” option. 

Step 5: In the - Fisher information matrix calculations - section of the window, access the Single 

integration method and select “Trapezoidal”. 

 

 

Figure 9.3.3:  FIM Single Integration Trapezoidal options 

 

Step 6: Click on the Additional parameters button next to the Single integration method pull-

down menu. In the dialog box that appears, enter Step size = 0.05. 

Step 7: Access the Double integration method pull-down menu in the - Fisher information 

matrix calculations - section of the window and select “Trapezoidal”. 

Step 8: Click on the Additional parameters button next to the Double integration method pull-

down menu. In the dialog box that appears, enter the values XGridding = 13 and YGridding = 13. 
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Figure 9.3.4:  FIM Double Integration Trapezoidal options 

 

Step 9: The - Fisher information matrix calculations - section has a subsection titled - Noise 

factor calculation parameters - . Enter values Limits of summation = [1, 3000] and Limits of 

integration = [-5000, 5000] in this subsection. 

Remark 14: The limits of integration and summation are initially set to default values which are 

automatically calculated based on the imaging conditions. It is possible specify these limits by changing the 

value of the combo box to the right of the limits of integration and summation fields.  

 

9.4. Executing the task and viewing results 

Step 1: In the main application window, click the Calculate Limits of Accuracy button. This will 

present a dialog box warning that the calculation may take a long time to complete. Click Yes to 

proceed. The Calculate button text will change to Calculating … and the application will temporarily 

become unresponsive while the calculations are being performed. 

 

Figure 9.4.1:  Calculation and Final confirmation 
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NOTE: During the calculation, a console window will be shown to inform the user about the different steps 

of the calculation. The calculation could indeed take half an hour to complete depending on the hardware 

capabilities of the platform on which the application is being executed. 

Step 2: When the calculation is completed, the Calculating … button text will change back to 

Calculate Limits of Accuracy and the Results window will be brought in focus. In addition, the 

console window will be hidden when the calculation is over. The console window can be accessed 

any time by selecting the Console option under the View Menu.  

 

 

Figure 9.4.2:  Results window (2D Resolution) 
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10. 3D-Resolution measure (Born-Wolf Model) 

This section provides an example of how to use the FandPLimitTool to calculate the accuracy 

with which the 3D location of two objects can be resolved from their image (PREM). The image of 

each object is assumed to be 3D Point Spread Function. 

The calculation takes into account the stochastic nature of the photon detection processes and 

assumes the photons detected from the object to be Poisson distributed. In addition, the calculation 

also takes into account extraneous noise sources - in particular the background component which is 

modeled as additive Poisson noise, the readout noise of the detector which is modeled as 

independent, additive Gaussian noise [2] and the electron multiplication noise of an EMCCD 

detector which is modeled as a branching process [3]. 

It is assumed that the pixels are rectangular in shape with no dead space between any two 

pixels. Further, the ROIs containing the images of the object are assumed to be rectangular arrays of 

pixels. The object is assumed to be in the center of this rectangular pixel array and the location of 

the object is specified with respect to the object space. 

Refer to [6] for details on 3D resolution accuracy in single molecule microscopy. 

 

 

 

10.1. Summary of imaging conditions 

The following table summarizes the imaging conditions under which the calculations are 

performed. 

Property Object 1 Object 2 

Numerical aperture 1.3 1.3 

Wavelength 0.52 μm 0.52 μm 

Photon detection rate 10,000 photons/second 10,000 photons/second 

Object medium refractive index 1.515 

d 0.1 μm 

phi π/4 radians 

omega π/3 radians 

Exposure time 0.13 seconds 

Magnification 100 X 

Location of object in ROI (sx, sy) 0.585 μm, 0.585 μm 

Axial location of object (sz) 0 μm 

Pixel size 13 μm × 13 μm 

ROI Size 9 pixels × 9 pixels  

Background level (Poisson rate) 1000 photons/pixel/second 1000 photons/pixel/second 

Gaussian noise mean 0 e
-
 

Gaussian noise standard deviation 8 e
-
 rms 

Use EM unchecked 

EM gain 100 

EM model Geometric 
 

Table 10.1.1: 3D Resolution Accuracy - Summary of imaging conditions 
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10.2. Providing required parameters 

Step 1: Select the calculation option “3D Resolution Accuracy – Point Spread Function (Born-

Wolf Model): Pixelated with Poisson + Gaussian Noise” from the Calculate pull-down menu in the 

main application window. 

Step 2: The required parameters window, which is visible by default, will be updated 

accordingly. If this window is not visible, access it by clicking the Required Parameters option under 

the Parameters Menu in the main application window. 

Step 3: In the - Object selection - section of the Required parameters window, select “Object 

1”. 

 

Figure 10.2.1: 3D Resolution Accuracy calculate type and its required parameters window 

 

Step 4: In the - Fundamental inputs – Object 1 - section of the window, enter the values for the 

various fields as follows: Numerical aperture = 1.3, Wavelength = 0.52, Photon detection rate = 

10000, Object medium refractive index = 1.515, d = 0.1, phi = pi/4, omega = pi/3 and Exposure time = 

0.13. 
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Step 5: In the - Additional inputs - section of the window, enter the values for the various fields 

as follows: Magnification = 100, sx = 13×4.5/100, sy = 13×4.5/100, sz = 0, Pixel size = [13, 13], and ROI 

size = [9, 9]. 

Remark 15: The center of a 9 pixels × 9 pixels pixel array where the dimensions of each pixel is 13 μm × 13 

μm, is (4.5 × 13)μm × (4.5 × 13)μm. To convert this location coordinates to the object space, the coordinate 

values are divided by the magnification. Hence the location coordinates are specified as 13×4.5/100 μm × 

13×4.5/100 μm. 

Step 6: In the - Extraneous noise sources – Object 1 - section of the window, enter the values for 

the various fields as follows: Background level = 1000 and Standard deviation = 8. 

Step 7: In the - Plane selection - section of the Required parameters window, select “Object 2”. 

Then repeat steps 4 and 6 for the Object 2. 

 

10.3. Providing advanced parameters 

NOTE: All inputs in the Advanced Parameters window are optional. The default values provided have 

been found to work adequately for typical imaging conditions. 

 

Figure 10.3.1:  3D Resolution Accuracy advanced parameters window 

Step 1: Access the advanced parameters window by clicking the Advanced Parameters option 

under the Parameters Menu. 
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Step 2: Skip the - Object selection - and - Advanced fundamental inputs (Object 1) - sections of 

the window. Their fields do not need to be changed as they are automatically calculated from the 

values entered in the Required Inputs window. 

Step 3: In the - Model profile calculations - section of window, access the Pixel integration 

method pull-down menu and select “Trapezoidal”. 

 

Figure 10.3.2:  Pixel Integration Trapezoidal options 

 

Step 4: Click the Additional parameters button next to the Pixel integration method pull-down 

menu. In the dialog box that appears, enter values for fields as follows: XGridding = 13, YGridding = 

13. Click OK when done. 

Step 5: Access the Model integration method pull-down menu in the same section of the window 

and select “Trapezoidal”. 

 

Figure 10.3.3:  Model Integration Trapezoidal options 

 

Step 6: Click the Additional parameters button next to the Model integration method pull-down 

menu. In the dialog box that appears, enter the values Step size = 0.0005, Lower limit = 0, and Upper 

limit = 1. Click OK when done. 

Step 7: Access the Background type pull-down menu and select “Constant”. There are no 

additional parameters to be accessed via the Additional parameters button for the “Constant” option. 
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Step 8: In the - Fisher information matrix calculations - section of the window, access the Single 

integration method pull-down menu and select “Trapezoidal”. 

 

Figure 10.3.4:  FIM Single Integration Trapezoidal options 

 

Step 9: Click the Additional parameters button next to the Single integration method pull- down 

menu. In the dialog box that appears, enter the values Step size = 0.0005, Lower limit = 0, and Upper 

limit = 1. Click OK when done. 

Step 10: Access the Double integration method pull-down menu in the same section of the 

window and select “Trapezoidal”. 

 

Figure 10.3.5:  FIM Double Integration Trapezoidal options 

 

Step 11: Click on the Additional parameters button next to the Double integration method pull-

down menu. In the dialog box that appears, enter the values XGridding = 13 and YGridding = 13. 

Step 12: The - Fisher information matrix calculations - section has a subsection titled - Noise 

factor calculation parameters - . Enter the following values in this subsection: Limits of summation = 

[1, 3000], Limits of integration = [-5000, 5000] and Trapezoidal integration step size = 0.05. 

Remark 16: The limits of integration and summation are initially set to default values which are 

automatically calculated based on the imaging conditions. It is possible specify these limits by changing the 

value of the combo box to the right of the limits of integration and summation fields.  
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10.4. Executing the task and viewing results 

Step 1: In the main application window, click the Calculate Limits of Accuracy button. This will 

present a dialog box warning that the calculation may take a long time to complete. Click Yes to 

proceed. The Calculate button text will change to Calculating … and the application will temporarily 

become unresponsive while the calculations are being performed. 

NOTE: The calculation could indeed take half an hour to complete depending on the hardware capabilities 

of the platform on which the application is being executed. 

 

 

Figure 10.4.1:  Calculation and Final confirmation (3D Resolution) 

 

Step 2: When the calculation is completed, the Calculating … button text will change back to 

Calculate Limits of Accuracy and the Results window will be brought in focus. 

 

 

Figure 10.4.2:  Results window (3D Resolution) 
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11. 3D-Localization accuracy measure - Multifocal Plane 

This section provides an example of how to use the FandPLimitTool to calculate the accuracy 

with which the 3D location of an object can be estimated from the images acquired by a 2-plane 

MUM setup (PLAM). The images of the object are assumed to be 3D Point Spread Function profiles. 

The calculation takes into account the stochastic nature of the photon detection processes and 

assumes the photons detected from the object to be Poisson distributed. In addition, the calculation 

also takes into account extraneous noise sources - in particular the background component which is 

modeled as additive Poisson noise, the readout noise of the detector which is modeled as 

independent, additive Gaussian noise and the electron multiplication noise which in modeled as a 

branching process. 

It is assumed that the pixels are rectangular in shape with no dead space between any two 

pixels. Further, the ROIs containing the images of the object are assumed to be rectangular arrays of 

pixels. The object is assumed to be in the center of this rectangular pixel array and the location of 

the object is specified with respect to the object space. Moreover, it is assumed that the photon 

detection process at each detector is independent of that of other detectors. Refer to [1] and [7] for 

details on determining the 3D localization accuracy in multifocal plane microscopy (MUM). 

 

11.1. Summary of imaging conditions 

The following table summarizes the imaging conditions under which the calculations are 

performed. 

Property Plane 1 Plane 2 

Z0 0.5 μm 

Alpha 15.708 

Object medium refractive index 1.515 

Numerical aperture 1.3 

Wavelength 0.52 μm 

Photon detection rate 10,000 photons/second 

Exposure time 0.13 seconds 

Magnification 100 X 

Photon detection rate ratio [0.5, 0.5] 

Focal plane distance [0, 0.5] μm 

Location of object in ROI 0.585 μm, 0.585 μm 

Pixel size 13 μm × 13 μm 

ROI Size 9 pixels × 9 pixels  

Background level (Poisson rate) 25 photons/pixel/second 25 photons/pixel/second 

Gaussian noise standard deviation 8 e
-
 rms 

Use EM unchecked 

EM gain 100 

EM model Geometric 
 

Table 11.1.1: 3D Localization Accuracy (MUM) - Summary of imaging conditions 
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11.2. Providing required parameters 

Step 1: Select the calculation option “3D Localization Accuracy - Multifocal: Pixelated with 

Poisson + Gaussian Noise” from the Calculate pull-down menu in the main application window. 

Step 2: The required parameters window, which is visible by default, will be updated 

accordingly. If this window is not visible, access it by clicking the Required Parameters option under 

the Parameters Menu in the main application window. 

Step 3: In the - Plane selection - section of the Required parameters window, select “Plane 1”. 

Step 4: In the - Fundamental inputs – Plane 1 - section of the window, enter the values for the 

various fields as follows: z0 = 0.5, Alpha = 15.708, Object medium refractive index = 1.515, Numerical 

aperture = 1.3, Wavelength = 0.52, Photon detection rate = 10000, and Exposure time = 0.13. 

 

Figure 11.2.1: 3D Localization Accuracy (MUM) calculate type and its required parameters window 

Step 5: In the - Additional inputs - section of the window, enter the values for the various fields 

as follows: Magnification = 100, Photon detection rate ratio = [0.5, 0.5], Focal plane distance = [0, 0.5], 

x0 = 13×4.5/100, y0 = 13×4.5/100, Pixel size = [13, 13], and ROI size = [9, 9]. 
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Remark 17: The center of a 9 pixels × 9 pixels pixel array where the dimensions of each pixel is 13 μm × 13 

μm, is (4.5 × 13)μm × (4.5 × 13)μm. To convert this location coordinates to the object space, the coordinate 

values are divided by the magnification. Hence the location coordinates are specified as 13×4.5/100 μm × 

13×4.5/100 μm. 

Step 6: In the - Extraneous noise sources – Plane 1 - section of the window, enter the values for 

the various fields as follows: Background level = 25 and Standard deviation = 8. 

Step 7: In the - Plane selection - section of the Required parameters window, select “Plane 2”. 

Then repeat step 6 for Plane 2. 

Remark 18: In case that the localization accuracy is required for an EMCCD detector, the Use EM checkbox 

should be checked and the desired value for the electron multiplication gain should entered in the EM gain 

field. For more information see Remark 2. 

Step 8: In the - Parameters to be estimated - section of the window, ensure that all check-boxes 

for all parameters are checked. 

 

11.3. Providing advanced parameters 

NOTE: All inputs in the Advanced Parameters window are optional. The default values provided have 

been found to work adequately for typical imaging conditions. 

Step 1: Access the advanced parameters window by clicking the Advanced Parameters option 

under the Parameters Menu. 

 

Figure 11.3.1:  3D Localization Accuracy (MUM) advanced parameters window 
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Step 2: The Advanced parameters window contains an - Advanced fundamental inputs - section. 

The default value of the field in this section can be left unchanged. 

Step 3: In the - Model profile calculations - section of window, access the Pixel integration 

method pull-down menu and select “Trapezoidal”. 

 

Figure 11.3.2:  Pixel Integration Trapezoidal options 

 

Step 4: Click the Additional parameters button next to the Pixel integration method pull-down 

menu. In the dialog box that appears, enter values for fields as follows: XGridding = 13, YGridding = 

13. Click OK when done. 

Step 5: Access the Model integration method pull-down menu in the same section of the window 

and select “Trapezoidal”. 

 

Figure 11.3.3:  Model Integration Trapezoidal options 

 

Step 6: Click the Additional parameters button next to the Model integration method pull-down 

menu. In the dialog box that appears, enter the values Step size = 0.0005, Lower limit = 0, and Upper 

limit = 1. Click OK when done. 

Step 7: Access the Background type pull-down menu and select “Constant”. There are no 

additional parameters to be accessed via the Additional parameters button for the “Constant” option. 
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Step 8: In the - Fisher information matrix calculations - section of the window, access the Single 

integration method pull-down menu and select “Trapezoidal”. 

 

Figure 11.3.4:  FIM Single Integration Trapezoidal options 

 

Step 9: Click the Additional parameters button next to the Single integration method pull- down 

menu. In the dialog box that appears, enter the values Step size = 0.0005, Lower limit = 0, and Upper 

limit = 1. Click OK when done. 

Step 10: Access the Double integration method pull-down menu in the same section of the 

window and select “Trapezoidal”. 

 

Figure 11.3.5:  FIM Double Integration Trapezoidal options 

 

Step 11: Click on the Additional parameters button next to the Double integration method pull-

down menu. In the dialog box that appears, enter the values XGridding = 13 and YGridding = 13. 

Step 12: The - Fisher information matrix calculations - section has a subsection titled - Noise 

factor calculation parameters - . Enter the following values in this subsection: Limits of summation = 

[1, 3000], Limits of integration = [-5000, 5000] and Trapezoidal integration step size = 0.05. 

Remark 20: The limits of integration and summation are initially set to default values which are 

automatically calculated based on the imaging conditions. It is possible specify these limits by changing the 

value of the combo box to the right of the limits of integration and summation fields.  
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11.4. Executing the task and viewing results 

Step 1: In the main application window, click the Calculate Limits of Accuracy button. This will 

present a dialog box warning that the calculation may take a long time to complete. Click Yes to 

proceed. The Calculate button text will change to Calculating … and the application will temporarily 

become unresponsive while the calculations are being performed. During the calculation, a console 

window will be shown to inform the user about the different steps of the calculation. 

NOTE: The calculation could indeed take half an hour to complete depending on the hardware capabilities 

of the platform on which the application is being executed. 

 

 

Figure 11.4.1:  Calculation and Final confirmation (3D localization MUM) 

 

Step 2: When the calculation is completed, the Calculating … button text will change back to 

Calculate Limits of Accuracy and the Results window will be brought in focus. In addition, the 

console window will be hidden when the calculation is over. 

 

 

Figure 11.4.2:  Results window (3D localization MUM) 
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